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R for Health Economics

• A survey conducted to previous IHPME health 
economics students suggested the following research 
interests
– Working with data

• Common tasks: reading in data, creating new variables, data 
subsets, etc.

• Example packages: base, tidyverse, data.table, etc.

– Applied econometrics
• Common tasks: descriptive analysis, regression analysis, etc.
• Example packages: stats, plm, lmtest, sandwich, etc.

– Economic Evaluation
• Common tasks: model building (Markov, Microsim, etc.), sensitivity 

analysis, etc.
• Example packages: base, stats, ggplot2, etc.
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Learning Curves of Various Software 
Packages

Source: https://sites.google.com/a/nyu.edu/statistical-software-guide/summary



Source: https://sites.google.com/a/nyu.edu/statistical-software-guide/summary

Summary of Various Statistical 
Software Packages



Goals of Today’s Talk

• Provide an overview of the use of R for data 
manipulation
– By doing so, we can hopefully lower the learning curve 

of R, thereby allowing us to take advantage of its “very 
strong” data manipulation capabilities

• Provide an overview of the use of R for statistical 
analysis
– This includes descriptive analysis (means, standard 

deviations, frequencies, etc.) as well as regression 
analysis

– R contains a wide number of pre-canned routines that 
we can use to implement the method we’d like to use



Part I
R Basics



Command Window Syntax Window



Programming Language

• Programming language in R is object oriented
– Roughly speaking, this means that data, variables, 

vectors, matrices, characters, arrays, etc. are 
treated as “objects” of a certain “class” that are 
created throughout the analysis and stored by 
name. 

– We then apply “methods” for certain “generic 
functions” to these objects

• Case sensitive (like most statistical software 
packages), so be careful



Classes in R

• In R, every object has a class

– For example, character variables are given the 
class of factor or character, whereas numeric 
variables are integer

• Classes determine how objects are handled by 
generic functions. For example:

– the mean(x) function will work for integers but not 
for factors or characters - which generally makes 
sense for these types of variables



Packages available (and loaded) in R by 
default

For database management, we usually won’t need to load or install any additional packages, 
although we might need the “foreign” package (available in R by default, but not initially loaded) 
or “haven” (not available in R by default, but can install) if we’re working with a dataset from 
another statistical program (SPSS, SAS, STATA, etc.)

Package Description
base Base R functions (and datasets before R 2.0.0).

compiler R byte code compiler (added in R 2.13.0).

datasets Base R datasets (added in R 2.0.0).

grDevices Graphics devices for base and grid graphics (added in R 2.0.0).

graphics R functions for base graphics.

grid A rewrite of the graphics layout capabilities, plus some support for interaction.

methods
Formally defined methods and classes for R objects, plus other programming tools, as 
described in the Green Book.

parallel
Support for parallel computation, including by forking and by sockets, and random-
number generation (added in R 2.14.0).

splines Regression spline functions and classes.

stats R statistical functions.

stats4 Statistical functions using S4 classes.

tcltk Interface and language bindings to Tcl/Tk GUI elements.

tools Tools for package development and administration.

utils R utility functions.

Source: https://cran.r-project.org/doc/FAQ/R-FAQ.html 



Packages in R

• Functions in R are stored in packages

– For example, the function for OLS (lm) is accessed via 
the “stats” package, which is available in R by default

– Only when a package is loaded will its contents be 
available. The full list of packages is not loaded by 
default for computational efficiency

– Some packages in R are not installed (and thus 
loaded) by default, meaning that we will have to 
install packages that we will need beforehand, and 
then load them later on



Packages in R (Continued)

• To load a package, type library(packagename)

– Ex: To load the foreign package, I would type library(foreign) before 
running any routines that require this package

• To install a package in R:

– Type install.packages(“packagename”) in command window

– For example, the package for panel data econometrics is plm in R. So, to 
install the plm package, I would type install.packages(“plm”).

• Note that, although installed, a package will not be loaded by default 
(i.e. when opening R). So, you’ll need library(package) at the top of 
your code (or at least sometime before the package is invoked).

– Some packages will draw upon functions in other packages, so those 
packages will need to be installed as well. By using install.packages(“ ”), it 
will automatically install dependent packages



Some Basic Operations in R

• Q: If x = 5, and y = 10, and z = x + y, what is the value of 
z?

• Let’s get R to do this for us:

x <- 5
y <- 10
z <- x + y
z

[1] 15

• In this example, we really only used the ‘+’ operator, 
but note that ‘-’, ‘/’, ‘*’, ‘^’, etc. work the way they 
usually do for scalar operations



Some Basic Operations in R
• Now suppose we created the following vectors:

• What is A + B?

A <- c(1, 2, 3)
B <- c(2, 4, 6)
Z <- A + B
Z

[1] 3 6 9

• Note that with vectors, ‘+’, ‘-’, ‘/’, ‘*’, ‘^’ perform element-wise calculations 
when applied to vectors. So, vectors need to be the same length.

1

2

3

2

4

6

A = B = 

In R, c() is used to combine 
values into a vector or list. Since 

we have multiple values, we 
need to use it here



Working with Matrices in R

• A matrix with typical element (i,j) takes the following form:

(1,1) (1,2) (1,3)

(2,1) (2,2) (2,3)

(3,1) (3,2) (3,3)

• Where i = row number and j = column number

• In R, the general formula for extracting elements (i.e. single 
entry, rows, columns) is as follows:

– matrixname[row #, column #]

• If we leave the terms in the brackets blank (or leave out the 
whole bracket term) R will spit out the whole matrix



Working with Matrices in R (Continued)
• Example: Suppose we had the following matrix:

1 4 7

2 5 8

3 6 9

• To create this matrix in R, type:

   mat <- matrix(c(1, 2, 3, 4, 5, 6, 7, 8, 9), nrow=3, ncol=3)

• Extract the element in row #2, column #3
mat[2,3]

[1] 8

• Extract the second row
mat[2,]

[1] 2 5 8

• Extract the last two columns
mat[,c(2,3)]

      [,1] [,2]

[1,]    4    7

[2,]    5    8

[3,]    6    9

Since we require 
multiple 
columns, we 
need to use c() 
here



Working with Matrices in R (Continued)

• Example: Suppose now we had the following vector (called vec), 
with typical element ‘i':

1

2

3

• Extract the third element of the vector

vec[3]

[1] 3

• Suppose the 2nd element should be 5, not 2. How do we correct 
this value?

vec[2] <- 5

vec

[1] 1 5 3



But wait a minute…

• Q: If this is a tutorial on the use of R for database 
manipulation/statistical analysis, then why are we 
learning about vectors/matrices?

• A: The way we work with data in R is very 
similar/identical to how we work with 
vectors/matrices
– This is different from other statistical software 

packages, which may be a contributing factor to the 
“high” learning curve in R

• The importance of vector/matrices operations 
will become more clear as we move



But wait a minute…(Continued)

• Knowledge of vector/matrix operations may also be useful for the building 
of decision models for economic evaluation

• Markov

– Alarid-Escudero, F., Krijkamp, E. M., Enns, E. A., Yang, A., 

Hunink, M. G., Pechlivanoglou, P., & Jalal, H. (2021). A Tutorial 

on time-dependent cohort state-transition models in R using a 

cost-effectiveness analysis example. arXiv preprint 
arXiv:2108.13552.

• Microsimulation

– Krijkamp, E. M., Alarid-Escudero, F., Enns, E. A., Jalal, H. J., 

Hunink, M. M., & Pechlivanoglou, P. (2018). Microsimulation 

modeling for health decision sciences using R: a tutorial. Medical 
Decision Making, 38(3), 400-422.



Part II
R for Data Manipulation



Reading Data into R

What format is the data in?
• Data from Comma Separated Values File (.csv)

– Package: utils
– Formula: read.csv(file, header = TRUE, sep = ",", quote = "\"", dec = ".", fill = 

TRUE, comment.char = "", ...)
• Data from Excel File (.xlsx) 

– Package: xlsx
– Formula: read.xlsx(file, sheetIndex, sheetName=NULL, rowIndex=NULL, 

startRow=NULL, endRow=NULL, colIndex=NULL, as.data.frame=TRUE, 
header=TRUE, colClasses=NA, keepFormulas=FALSE, encoding="unknown", ...)

• Data from STATA (.dta)
– Package: haven
– Formula: read_dta(file, encoding = NULL, col_select = NULL, skip = 0, n_max = 

Inf, .name_repair = "unique")

Other Formats: See package “haven”
https://cran.r-project.org/web/packages/haven/haven.pdf



Reading Data into R

Examples:
• CSV file with variable names at top

– data <- read.csv(“C:/Users/adrianrohitdass/Documents/R 
Tutorial/data.csv”)

• CSV file with no variable names at top
– data <- read.csv(“C:/Users/adrianrohitdass/Documents/R 

Tutorial/data.csv”, header=F)

• STATA data file
– library(haven)
– data <- read_dta(“C:/Users/adrianrohitdass/Documents/R 

Tutorial/data.dta”)

• SAS
– library(haven)
– data <- read_sas(“C:/Users/adrianrohitdass/Documents/R 

Tutorial/data.sas7bdat”)



Comparison and Logical Operators

Operator Description Example

= Assign a value x = 5

<- Assign a value x <- 5

== Equal to sex ==1

!= Not equal to LHIN != 5

> Greater than income >5000

< Less than healthcost < 5000

>= or <= Greater than or equal to
Less than or equal to

income >= 5000
healthcost <= 5000

& And sex==1 & age>50

| Or LHIN==1 | LHIN ==5



Referring to Variables in a Dataset

• Suppose I had data stored in “mydata” (i.e an 
object created to store the data read-in from a 
.csv by R). To refer to a specific variable in the 
dataset, I could type

mydata$varname

Name of Dataset Name of Variable in dataset

‘$’ used in R to extract named 
elements from a list



Creating a new variable/object

• No specific command to generate new 
variables (in contrast to STATA’s “gen” and 
“egen” commands)

– x <- 5 generates a 1x1 scalar called “x” that is 
equal to 5

– data$age <- year – data$dob creates a new 
variable “age” in the dataset “data” that is equal 
to the year – the person’s date of birth (let’s say in 
years)



Looking at Data

• Display the first or last few entries of a dataset:
– Package: utils
– View entire dataset in separate window

• View(x, title)

– View structure of dataset
• str(object, ...)

– First few elements of dataset (default is 5):
• head(x, n, …)

– Last few elements of dataset (default is 5): 
• tail(x, n, …)

• List of column names in dataset
– Package: base
– Formula: colnames(x)



Missing Values

Missing Values are listed as “NA” in R

• Count number of NA’s in column

sum(is.na(x))

• Recode Certain Values as NA (i.e. non 
responses coded as -1)

x[x==-1] <- NA



Renaming Variables (Columns)

A few different ways to do this:

• To rename the ‘ith’ column in a dataset

–  colnames(data)[i] <- “My Column Name”

• Can be cumbersome – especially if don’t know column # of the 
column you want to rename (just it’s original name)

• Alternative:

–  colnames(data)[which(colnames(data) == “R1482600”)] <- “race”

Grabs column names 
from specified 

dataset

Look-up that returns 
the column #  

New column name



Subsetting Data

• Subsetting can be used to restrict the sample in the dataset, create 
a smaller data with fewer variables, or both

• Recall: extracting elements from a matrix in R

• matrixname[row #, column #]

• What’s the difference between a matrix and a dataset?

– Both have row elements

• Typically the individual records in a dataset

– Both have column elements

• Typically the different variables in the dataset

• If we think of our dataset as a matrix, then the concept of 
subsetting in R becomes a lot easier to digest



Subsetting Data (Continued)

Examples:

• Restrict sample to those with age >=50
>  datas1 <- data[data$age >=50,]

• Create a smaller dataset with just ID, age, and 
height
> datas2 <- data[, c(“ID”, “age”, “height”)]

• Create a smaller dataset with just ID, age, and 
height; with age >=50
> datas3 <- data[data$age>=50, c(“ID”, “age”, “height”)]



Part II

R for Statistical Analysis



Descriptive Statistics in R

• Mean
– Package: base

– Formula: mean(x, trim = 0, na.rm = FALSE, ...)

• Standard Deviation
– Package: stats

– Formula: sd(x, na.rm = FALSE)

• Correlation
– Package: stats

– Formula: cor(x, y = NULL, use = "everything”, method 
= c("pearson", "kendall", "spearman"))



Descriptive Statistics (Example)

• Suppose we had the following data column in 
R (transposed to fit on slide):

– Vector = [5,5,6,4]

• What is the mean of the vector?

• In R, I would type

>  mean(Vector)

>  5



Descriptive Statistics (Example)

• Suppose now we had the following:
– Vector = [5,5,6,4,NA]

• What is the mean of the vector?
• In R, I would type

>  mean(Vector)
>  NA

• Why did I get a mean of NA?
– Our vector included a missing value, so R couldn’t 

compute the mean as is. 
• To remedy this, I would type

>  mean(Vector, na.rm=T)
>  5



Graphing Data in R

• Generic X-Y Plotting

– Package: graphics

– Formula: plot(x, y, ...)

Example:

plot(cost.data$income,cost.data$totexp)

• Plotting with ggplot() function

– Package: ggplot2

– Formula: ggplot(data = NULL, mapping = aes(), ..., environment = 
parent.frame())

Example:

ggplot(cost.data, aes(x=income, y=totexp)) + geom_point()



Resulting Graph (Generic)



Resulting Graph (ggplot2)

See https://github.com/rstudio/cheatsheets/raw/master/data-visualization.pdf for 
ggplot cheatsheet

https://github.com/rstudio/cheatsheets/raw/master/data-visualization.pdf


Ordinary Least Squares

• The estimator of the regression intercept and slope(s) that minimizes the sum of 
squared residuals (Stock and Watson, 2007).

– Package: stats
– Formula: lm(formula, data, subset, weights, na.action, method = "qr", model = 

TRUE, x = FALSE, y = FALSE, qr = TRUE, singular.ok = TRUE, contrasts = NULL, 
offset, ...)

Examples:

Regression of “total health care expenditure” on “age, gender, household income, 
supplementary insurance status (insurance beyond Medicare), physical and activity 
limitations and the total number of chronic conditions” using dataset “cost.data” from 
Medical Expenditure Panel Survey (65+)

ols.costdata <- lm(totexp ~ age + female + income + suppins + phylim + actlim + totchr, 
data = cost.data)

Online Help File
https://stat.ethz.ch/R-manual/R-devel/library/stats/html/lm.html



Ordinary Least Squares

Example adapted from Jones (2013) Applied Health Economics



Post-Estimation
Package: lmtest

• Breusch-Pagan test for heteroskedasticity. 

bptest(formula, varformula = NULL, studentize = TRUE, data = list()) 

• Ramsey’s RESET test for functional form. 

resettest(formula, power = 2:3, type = c("fitted", "regressor", "princomp"), 
data = list())

Package: car

• Variance Inflation Factor (VIF)

vif(model)

Package: sandwich

• Heteroskedasticity-Consistent Covariance Matrix Estimation
coeftest(ols.costdata, vcovHC(ols.costdata, type = "HC1"))

Notes: need to combine with lmtest coeftest() command, and use type = 
“HC1” to get the same results as STATA’s “robust” command



Extracting Beta coefficients, standard 
errors, etc. from model

• A couple of ways to do this, but most of the information we’re after is stored in the 
coefficients object returned from summary:

• The above is a matrix, so we can get the information we need through column 
extractions:

– Beta coefficients: summary(ols.costdata)$coefficients[,1]

– Standard errors: summary(ols.costdata)$coefficients[,2]

– T-value: summary(ols.costdata)$coefficients[,3]

– P-value: summary(ols.costdata)$coefficients[,4]



Residuals vs Fitted Values

• For Residuals vs Fitted Values (RVFV) Plot, use generic plot() function on 
regression object. First plot is RVFV

• Formula: plot(ols.costdata, 1)

*Other diagnostic plots can be produced as well. See Kleiber & Zeileis (2008) for more 



Applied Example

• Analysis of Health Expenditure Data in Jones et al. 
(2013) Chapter Three

• The data covers the medical expenditures of US citizens 
aged 65 years and older who qualify for health care 
under Medicare.
– Outcome of interest is total annual health care 

expenditures (measured in US dollars).
– Other key variables are age, gender, household income, 

supplementary insurance status (insurance beyond 
Medicare), physical and activity limitations and the total 
number of chronic conditions.

• Data can be downloaded from here (mus03data.dta): 
https://www.stata-press.com/data/musr.html

https://www.stata-press.com/data/musr.html


Code for applied Example

rm(list = ls())                         # remove any variables in R's memory

# Set working directory ----
setwd("/Users/Desktop/Example") #Set working directory

# Load R Packages ----
library(haven)
library(lmtest)
library(sandwich)

# Load Data ----
cost.data.all <- read_dta("mus03data.dta") #read_dta from haven package

## Get more info on dataset ----
str(cost.data.all)

# Clean Data ----
cost.data <- cost.data.all[cost.data.all$totexp>0,] #Restrict dataset to positive expenditures following textbook

# Regression ----
ols.costdata <- lm(totexp ~ age + female + income + suppins + phylim + actlim + totchr, data = cost.data)

## Results with HC robust standard errors ----
ols.costdata.robust <- coeftest(ols.costdata , vcovHC(ols.costdata , type = "HC1")) # Should match Table 3.3 in Book

# Export Results (as csv file) ----
costdata.results.robust = data.frame("Variable" = rownames(ols.costdata.robust),
                                     "Beta" = ols.costdata.robust[,1],
                                     "SE" = ols.costdata.robust[,2],
                                     "Pvalue" = round(ols.costdata.robust[,4], 4),
                                     row.names = NULL)

write.csv(costdata.results.robust, "costregresults.csv", row.names = FALSE)



Instrumental Variables

A way to obtain a consistent estimator of the unknown 
coefficients of the population regression function when the 
regressor, X, is correlated with the error term, u. (Stock and 
Watson, 2007).

Package: AER

Formula: ivreg(formula, instruments, data, subset, na.action, 
weights, offset, contrasts = NULL, model = TRUE, y = TRUE, x = 
FALSE, ...)

Online documentation: https://cran.r-
project.org/web/packages/AER/AER.pdf



IV Example
Example: Determinants of Income (As a function of Health)

Prints out F-test for 
Weak Instruments, 

Hausman Test 
Statistic (vs ols) and 

Sargan’s Test for 
Over-identifying 

Restrictions (if more 
than one instrument 

use)



Models for Binary Outcomes

• R does not come with different programs for binary outcomes. Instead, it 
utilizes a unifying framework of generalized linear models (GLMs) and a 
single fitting function, glm() (Kleiber & Zeileis (2008))

Package: stats
Formula: glm(formula, family = gaussian, data, weights, subset, na.action, 
start = NULL, etastart, mustart, offset, control = list(...), model = TRUE, 
method = "glm.fit”, x = FALSE, y = TRUE, contrasts = NULL, ...)

• For binary outcomes, we specify family=“binomial” and link= “logit” or 
“probit”

• Can be extended to count data as well (family=“poisson”)

Online help: https://stat.ethz.ch/R-manual/R-
devel/library/stats/html/glm.html

https://stat.ethz.ch/R-manual/R-devel/library/stats/html/glm.html
https://stat.ethz.ch/R-manual/R-devel/library/stats/html/glm.html


Other Regression Models

• Panel Data Econometrics
– Package: plm

– https://cran.r-
project.org/web/packages/plm/vignettes/plm.pdf

• Linear and Generalized Linear Mixed Effects Models
– Package: lme4

– https://cran.r-project.org/web/packages/lme4/lme4.pdf

• Quantile Regression
– Package: quantreg

– https://cran.r-
project.org/web/packages/quantreg/quantreg.pdf

https://cran.r-project.org/web/packages/plm/vignettes/plm.pdf
https://cran.r-project.org/web/packages/plm/vignettes/plm.pdf
https://cran.r-project.org/web/packages/quantreg/quantreg.pdf
https://cran.r-project.org/web/packages/quantreg/quantreg.pdf


Part III
Other topics in R



Tidyverse



Tidyverse

From Tidyverse website:

“The tidyverse is an opinionated collection of R packages 
designed for data science. All packages share an underlying 
design philosophy, grammar, and data structures…tidyverse 
makes data science faster, easier and more fun”

Source: https://www.tidyverse.org

• Packages within tidyverse: ggplot2, dplyr, tidyr, readr, purrr, 
tibble, stringr, and forcats

• To get, type: install.packages(“tidyverse”) in R console

https://www.tidyverse.org/


Tidyverse (Continued)
Package: dplyr 

• Description: provides a flexible grammar of data 
manipulation. 

• Example Commands:
– Restrict sample to those with age >=50

• subdata <- filter(data, age>=50)

– Create a smaller dataset with just ID, age, and height
• subdata <- select(data, ID, age, height)

– Create a smaller dataset with just ID, age, and height; 
with age >=50
• subdata <- data %>%

filter(age>=50) %>%
select(ID, age, height)



Tidyverse (Continued)

Package: dplyr 

• Example Commands (continued):
– Create new variable (age) in existing dataset

• data <- mutate(data, age = year – dob)

– Rename a variable in a dataset (new name = old 
name)
• data <- rename(data, race = R1482600)

• https://cran.r-
project.org/web/packages/dplyr/dplyr.pdf

https://cran.r-project.org/web/packages/dplyr/dplyr.pdf
https://cran.r-project.org/web/packages/dplyr/dplyr.pdf


Tidyverse (Continued)

Other (selected) packages in Tidyverse:

• Package: readr
– Description: The goal of 'readr' is to provide a fast and 

friendly way to read rectangular data (like 'csv', 'tsv', and 
'fwf’)

– https://cran.r-project.org/web/packages/readr/readr.pdf

• Package: tidyr
– Description: Tools for reshaping data, extracting values out 

of string columns, and working with missing values

– https://cran.r-project.org/web/packages/tidyr/tidyr.pdf

https://cran.r-project.org/web/packages/readr/readr.pdf
https://cran.r-project.org/web/packages/tidyr/tidyr.pdf


Code for Applied Example

rm(list = ls())                         # remove any variables in R's memory

# Set working directory ----
setwd("/Users/Desktop/Example") #Set working directory

# Load R Packages ----
library(tidyverse)
library(lmtest)
library(sandwich)

# Load Data ----
cost.data.all <- read_dta("mus03data.dta") #read_dta from haven package

## Get more info on dataset ----
str(cost.data.all)

# Clean Data ----
cost.data <- filter(cost.data.all, totexp>0) #Restrict dataset to positive expenditures following textbook

# Regression ----
ols.costdata <- lm(totexp ~ age + female + income + suppins + phylim + actlim + totchr, data = cost.data)

## Results with HC robust standard errors ----
ols.costdata.robust <- coeftest(ols.costdata , vcovHC(ols.costdata , type = "HC1")) # Should match Table 3.3 in Book

# Export Results (as csv file) ----
costdata.results.robust = data.frame("Variable" = rownames(ols.costdata.robust),
                                     "Beta" = ols.costdata.robust[,1],
                                     "SE" = ols.costdata.robust[,2],
                                     "Pvalue" = round(ols.costdata.robust[,4], 4),
                                     row.names = NULL)

write.csv(costdata.results.robust, "costregresults.csv", row.names = FALSE)



data.table Package in R



data.table Package in R (Continued)

Package: data.table

Description from documentation: Fast aggregation of large data (e.g. 100GB in 
RAM), fast ordered joins, fast add/modify/delete of columns by group using no 
copies at all, list columns, friendly and fast character-separated-value read/write. 
Offers a natural and flexible syntax, for faster development. 

General syntax

DT[i, j, by]

Source: https://cran.r-project.org/web/packages/data.table/data.table.pdf

https://cran.r-project.org/web/packages/data.table/data.table.pdf


data.table Package in R (Continued)

Why data.table? Factors to consider:
• Speed
• Memory Usage
• Syntax
• Features

See full discussion: https://stackoverflow.com/questions/21435339/data-
table-vs-dplyr-can-one-do-something-well-the-other-cant-or-does-poorly

A note on computational efficiency
– Quote from Xu et al. (2016): “The authors have worked on several cases, in 

which analysis can be significantly improved by just replacing the usage of 
data frame with data table package.” Empowering R with High Performance 
Computing Resources for Big Data Analytics

https://stackoverflow.com/questions/21435339/data-table-vs-dplyr-can-one-do-something-well-the-other-cant-or-does-poorly
https://stackoverflow.com/questions/21435339/data-table-vs-dplyr-can-one-do-something-well-the-other-cant-or-does-poorly


data.table Package in R (Continued)

Syntax comparisons
• Base R
read.csv(file, ...)
• Tidyverse (readr package)
read_csv(file, …)
• data.table
fread(file,…)

How do the load times compare? Test on Canadian 
Community Health Survey 2013/14, 285.4 MB



Full Code for Applied Example

# Base R ----
t1 <- Sys.time()
d1 <- read.csv("cchs201314.csv")
comp.time1 <- Sys.time() - t1

# Tidyverse (readr package) ----
library(readr)
t2 <- Sys.time()
d2 <- read_csv("cchs201314.csv")
comp.time2 <- Sys.time() - t2

# data.table ----
library(data.table)
t3 <- Sys.time()
d3 <- fread("cchs201314.csv")
comp.time3 <- Sys.time() - t3



data.table Package in R (Continued)

Subset Data: Age group >=3 (18 and over)

• Base R

cchs.sub <- cchsdata[cchsdata$DHHGAGE>=3,]

• Tidyverse

cchs.sub <- filter(cchsdata, DHHGAGE>=3)

• data.table

cchs.sub <- cchsdata[DHHGAGE>=3]



data.table Package in R (Continued)

Create new variable: flag (=1) for age group >=3 (18 
and over), 0 otherwise
• Base R
cchs$age_flag <- 0
cchs$age_flag[cchs$DHHGAGE>=3] <- 1
• Tidyverse
cchs <- mutate(cchs, age_flag = 
ifelse(DHHGAGE>=3, 1, 0))
• data.table
cchs[,age_flag:=ifelse(DHHGAGE>=3, 1, 0)]



data.table Package in R (Continued)

Frequency of Age Group variable (CCHS)
• Base R
ftable <- table(cchsdata$DHHGAGE)
•  Tidyverse (dplyr package)
ftable <- cchsdata %>%
 group_by(DHHGAGE) %>%
 summarize(freq = n())
• data.table
ftable <- cchsdata[,.(.N),by=DHHGAGE]



Code for Applied Example
rm(list = ls())                         # remove any variables in R's memory

# Set working directory ----
setwd("/Users/Desktop/Example") #Set working directory

# Load R Packages ----
library(haven)
library(lmtest)
library(sandwich)
library(data.table)

# Load Data ----
cost.data.all <- data.table(read_dta("mus03data.dta")) #read_dta from haven package

## Get more info on dataset ----
str(cost.data.all)

# Clean Data ----
cost.data <- cost.data.all[totexp>0] #Restrict dataset to positive expenditures following textbook

# Regression ----
ols.costdata <- lm(totexp ~ age + female + income + suppins + phylim + actlim + totchr, data = cost.data)

## Results with HC robust standard errors ----
ols.costdata.robust <- coeftest(ols.costdata , vcovHC(ols.costdata , type = "HC1")) # Should match Table 3.3 in Book

# Export Results (as csv file) ----
costdata.results.robust = data.frame("Variable" = rownames(ols.costdata.robust),
                                     "Beta" = ols.costdata.robust[,1],
                                     "SE" = ols.costdata.robust[,2],
                                     "Pvalue" = round(ols.costdata.robust[,4], 4),
                                     row.names = NULL)

write.csv(costdata.results.robust, "costregresults.csv", row.names = FALSE)



R Studio



What is R Studio?

From R Studio Website:
• An integrated development environment (IDE) for R. 

Includes:
– A console
– Syntax highlighting editor
– Tools for plotting, history, debugging, and workspace 

history

• Can think of it as a more user friendly version of R
• A free version is available as well
• For more information, see 

https://posit.co/download/rstudio-desktop/

https://posit.co/download/rstudio-desktop/


Command/Results Window

Syntax Window

List of datasets/variables

Files, plots, packages, help, and viewer



R Markdown



What is R Markdown?

From R Markdown website:
“R Markdown provides an authoring framework for data science. You 
can use a single R Markdown file to both
• save and execute code
• generate high quality reports that can be shared with an audience”
Source: https://rmarkdown.rstudio.com/lesson-1.html

With R Markdown, you can render to a variety of formats, which 
includes PDF (uses LaTeX) and Microsoft Word

To create a R Markdown file, go to File → New File → R Markdown

https://rmarkdown.rstudio.com/lesson-1.html
https://en.wikipedia.org/wiki/LaTeX


Global options for document here (echoing of R code, loading 
packages, etc.)

# for Document Sections

“Knit”, or generate document

R code chunk for output (summary of “cars” data)

R code chunk for output (to insert a plot available in R memory)



Page 1 (of 2)



Page 2 (of 2)



Tips for Outputting In MS Word
Output Option • The word_document2 (Bookdown) and rdocx_document (Officedown) formats are 

generally superior to word_document (default in R Markdown), particularly for 
automatic numbering of figures/tables, and cross-referencing of figures/tables. 

• The rdocx_document lets you easily switch between landscape and portrait

Tables Default knitr::kable() function works, but flextable() function flextable creates “pretty” 
tables with a large amount of flexibility (customize cell padding and column widths, table 
footnotes, long tables, etc.)

Figures Use knitr::include_graphics(filepath) for previously saved figures to include in the 
document

References • Default reference style is Chicago. Visit Zotero Style Repository to search for additional 
Citation Style Language (CSL) files (Vancouver, APA, journal specific styles, etc.). Can 
modify existing reference style, which may be necessary for certain journals 
(https://editor.citationstyles.org/about/)

• Add citations with markdown syntax by typing [@cite] or @cite.
• Store references in plain text BibTeX database (*.bib)
• Can also look up and Insert Citations dialog in the Visual Editor by clicking the @ 

symbol in the toolbar or by clicking Insert > Citation

Document 
formatting

To modify font sizes, text alignment, etc., need to create a reference style document 
following these instructions: https://rmarkdown.rstudio.com/articles_docx.html

Please also see the R Markdown cheat sheet: 
https://github.com/rstudio/cheatsheets/raw/master/rmarkdown-2.0.pdf

https://bookdown.org/yihui/bookdown/a-single-document.html
https://cran.r-project.org/web/packages/officedown/index.html
https://cran.r-project.org/web/packages/flextable/index.html
https://www.zotero.org/styles
https://editor.citationstyles.org/about/
https://rmarkdown.rstudio.com/articles_docx.html
https://github.com/rstudio/cheatsheets/raw/master/rmarkdown-2.0.pdf


Applied Example 2

• Create a R markdown document using the 
results from the first applied example

• Export to be done in Word



Code from Example

---

author: "Author Name"

title: "Essays on the use of R"

subtitle: "An Example Document"

date: "`r Sys.Date()`"

output: word_document

---

```{r setup, include=FALSE}

knitr::opts_chunk$set(echo = FALSE)

rm(list = ls())                         # remove any variables in R's memory

setwd("/Users/Desktop/Example") #Set working directory

```

# Introduction

This is an example document.

# Results

## Regression Results Table

```{r}

cost.data.results = read.csv("costregresults.csv")

knitr::kable(cost.data.results)

```



Conclusions 

• R has extremely powerful data manipulation capabilities
– Is fully capable of performing the same sort of tasks as 

commercial software programs
– Can be enhanced through Tidyverse package for a more user 

friendly experience.
– Can also be enhanced through data.table package (e.g., large 

datasets)

• R is very capable of statistical analysis
– Is fully capable of calculating summary statistics and performing 

regression analysis right out of the box
– Can install additional packages to perform other sorts of 

analysis, depending on the research question of the user

• R, and the additional packages available to enhance the use 
of R, are available free of charge



R Resources



R Online Resources

• A list of R packages is contained here:

https://cran.r-
project.org/web/packages/available_packages_by_
date.html

• By clicking on a particular package, you’ll be 
taken to a page with more details, as well as a link 
to download the documation

• Typing help(topic) in R pulls up a brief help file 
with synax and examples, but the online manuals 
contain more detail

https://cran.r-project.org/web/packages/available_packages_by_date.html
https://cran.r-project.org/web/packages/available_packages_by_date.html
https://cran.r-project.org/web/packages/available_packages_by_date.html


R Online Resources

• UCLA Institute for Digital Research and 
Education

– List of topics and R resources (getting started, data 
examples, etc.) can be found here: 
http://www.ats.ucla.edu/stat/r/

• RStudio (posit) Cheatsheets

– https://posit.co/resources/cheatsheets/

http://www.ats.ucla.edu/stat/r/
https://posit.co/resources/cheatsheets/


Other R Resources

1. Kleiber, C., & Zeileis, A. (2008). Applied econometrics with 
R. Springer Science & Business Media.
• Great reference for the applied researcher wanting to use R for 

econometric analysis. Includes R basics, linear regression 
model, panel data models, binary outcomes, etc.

2. Jones, A. M., Rice, N., d'Uva, T. B., & Balia, S. 
(2013). Applied health economics. Routledge. 
• Excellent reference for applied health economics. Examples 

are all performed using STATA, but haven package should help 
here.

3. CRAN Task View: Econometrics
• A listing of the statistical models used in econometrics, as well 

as the R package(s) needed to perform them. Available at: 
https://cran.r-project.org/view=Econometrics

https://cran.r-project.org/view=Econometrics


Other R Resources (Continued)

Resources for economic evaluation using R

4) Krijkamp, E. M., Alarid-Escudero, F., Enns, E. A., Jalal, H. J., Hunink, 
M. M., & Pechlivanoglou, P. (2018). Microsimulation modeling for 
health decision sciences using R: a tutorial. Medical Decision Making, 
38(3), 400-422.
Chicago 
5) Jalal, H., Pechlivanoglou, P., Krijkamp, E., Alarid-Escudero, F., Enns, 
E., & Hunink, M. M. (2017). An overview of R in health decision 
sciences. Medical decision making, 37(7), 735-746.
6) Alarid-Escudero, F., Krijkamp, E. M., Enns, E. A., Yang, A., 
Hunink, M. G., Pechlivanoglou, P., & Jalal, H. (2021). A Tutorial 
on time-dependent cohort state-transition models in R using a 
cost-effectiveness analysis example. arXiv preprint 
arXiv:2108.13552.



     
                             Thanks for Listening
       Good luck with R!


	Slide 1: Introduction to R
	Slide 2: R for Health Economics
	Slide 3: Outline
	Slide 4: Learning Curves of Various Software Packages
	Slide 5: Summary of Various Statistical Software Packages
	Slide 6: Goals of Today’s Talk
	Slide 7: Part I R Basics
	Slide 8
	Slide 9: Programming Language
	Slide 10: Classes in R
	Slide 11: Packages available (and loaded) in R by default
	Slide 12: Packages in R
	Slide 13: Packages in R (Continued)
	Slide 14: Some Basic Operations in R
	Slide 15: Some Basic Operations in R
	Slide 16: Working with Matrices in R
	Slide 17: Working with Matrices in R (Continued)
	Slide 18: Working with Matrices in R (Continued)
	Slide 19: But wait a minute…
	Slide 20: But wait a minute…(Continued)
	Slide 21: Part II R for Data Manipulation
	Slide 22: Reading Data into R
	Slide 23: Reading Data into R
	Slide 24: Comparison and Logical Operators
	Slide 25: Referring to Variables in a Dataset
	Slide 26: Creating a new variable/object
	Slide 27: Looking at Data
	Slide 28: Missing Values
	Slide 29: Renaming Variables (Columns)
	Slide 30: Subsetting Data
	Slide 31: Subsetting Data (Continued)
	Slide 32: Part II  R for Statistical Analysis
	Slide 33: Descriptive Statistics in R
	Slide 34: Descriptive Statistics (Example)
	Slide 35: Descriptive Statistics (Example)
	Slide 36: Graphing Data in R
	Slide 37: Resulting Graph (Generic)
	Slide 38: Resulting Graph (ggplot2)
	Slide 39: Ordinary Least Squares
	Slide 40: Ordinary Least Squares
	Slide 41: Post-Estimation
	Slide 42: Extracting Beta coefficients, standard errors, etc. from model
	Slide 43: Residuals vs Fitted Values
	Slide 44: Applied Example
	Slide 45: Code for applied Example
	Slide 46: Instrumental Variables
	Slide 47: IV Example
	Slide 48: Models for Binary Outcomes
	Slide 49: Other Regression Models
	Slide 50: Part III Other topics in R
	Slide 51: Tidyverse
	Slide 52: Tidyverse
	Slide 53: Tidyverse (Continued)
	Slide 54: Tidyverse (Continued)
	Slide 55: Tidyverse (Continued)
	Slide 56: Code for Applied Example
	Slide 57: data.table Package in R
	Slide 58: data.table Package in R (Continued)
	Slide 59: data.table Package in R (Continued)
	Slide 60: data.table Package in R (Continued)
	Slide 61: Full Code for Applied Example
	Slide 62: data.table Package in R (Continued)
	Slide 63: data.table Package in R (Continued)
	Slide 64: data.table Package in R (Continued)
	Slide 65: Code for Applied Example
	Slide 66: R Studio
	Slide 67: What is R Studio?
	Slide 68
	Slide 69: R Markdown
	Slide 70: What is R Markdown?
	Slide 71
	Slide 72: Page 1 (of 2)
	Slide 73: Page 2 (of 2)
	Slide 74: Tips for Outputting In MS Word
	Slide 75: Applied Example 2
	Slide 76: Code from Example
	Slide 77: Conclusions 
	Slide 78
	Slide 79: R Online Resources
	Slide 80: R Online Resources
	Slide 81: Other R Resources
	Slide 82: Other R Resources (Continued)
	Slide 83

